
Blending Sliders



Blending Sliders © Ben Willmore, All rights reserved 2

Blending Sliders

The Blending sliders are a feature that have been in Photoshop for a long time. Not 
many people use them, but they can be incredible useful once you understand 
how they work, and that is what we’ll cover in this lesson.

Blending sliders: Where they are and what they do

The blending sliders can be found within 
the Blending Options section in the Lay-
er Style dialog box. You can access this 
dialog by double-clicking to the right of 
a layer’s name in the Layers panel or by 
clicking on the FX icon at the bottom of the Layers panel and choosing Blend-
ing Options from the pop-up menu. In the Blending Options section of this Layer 
Style dialog, the blending sliders can be found at the bottom.

In the Layer 
Style dialog, 
the blending 
sliders can 
be found 
at the bot-
tom of the 
Blending 
Options  
category.

Click in this empty area to the right of the 
layer’s name to access the Blending Options.
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Note: If you’re working on the Background layer, you will not be able to access the 
Blending Options dialog unless you first unlock the layer. Unlock the layer simply 
by double-clicking on it in the Layers panel. A dialog will appear, asking you to 
name the layer and then click OK. 

There is a set of sliders labeled “This Layer,” which will control the visibility of the 
active layer, and there are a set of sliders labeled “Underlying Layer.” These sliders 
should actually be labeled “Underlying Image” because it’s looking at what the 
document looks like as a combination of all the layers stacked beneath the active 
layer.

This Layer Sliders

Looking at the settings for “This Layer,” there 
are two sliders set on a gradient bar, which 
represents the brightness range in the layer. 
The slider on the left controls the dark areas 
in the layer and the slider on the right controls 
the bright areas of the layer. If we take that 
white slider and drag it to the left, all the white 
areas in the layer will disappear. If we continue 
to drag it to the left, the brighter and brighter 
shades within the image will start to disappear as well. So what is happening here? 
Any areas of the layer that can be found in the brightness range to the right of 
the slider will become hidden. Any areas that can be found within the brightness 
range to the left of the slider will be visible. 

The black slider, located on the left side of the gradient bar, works in the same way. 
When we drag the black slider to the right, anything that’s pure black in the image 
will become hidden. The more we drag the slider to the right, the more dark areas 
will become invisible. 

Splitting the sliders When we drag the sliders to hide/reveal different brightness 
ranges, the transition between what remains visible and what is hidden will be an 
abrupt, hard edge. There is also a way to create a soft, gradual transition. If you 

The This Layer sliders control the visi-
bility of the active layer.
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look closely at each of the sliders, you’ll no-
tice a vertical line in the middle of each one. 
This means that each slider is actually split 
into two parts, and those two halves can be 
separated by holding down the Option key 
(Alt on Win) and dragging one half away 
from the other. When you separate the slid-
er, you will be creating a gradual transition 
between what is visible and what is hidden. 
When we’re working with the white slider, 
anything to the right of the right half of the slider will be hidden. Anything to the 
left of the left half of the slider will be visible. The area in between is where the 
transition will occur, so these areas will be partially visible. The farther apart the 
two sliders halves are, the softer the transition will be. 

When to use the This Layer sliders

Isolate part of an image In the video example, we have an image of a sky with 
lightning in it. We’re going to use the blending sliders to hide everything but the 
lightning. This way, we can place the lightning into a different document and make 
it look as if it’s appearing on another sky. We’ll double-click on the lightning layer 
in order to bring up the Blending Options section of the Layer Style dialog box. 

We’ll then drag the black slider to the 
right, making more and more of the 
dark areas invisible. We’ll also split the 
slider in half in order to create a grad-
ual transition between the sky and the 
glowy part of the lightning. Remem-
ber, to split the slider in half, we’ll hold 
down the Option key (Alt on Win) and 
drag one half of the slider.

The black slider was split in half in order 
to create a soft transition. Everything to 
the left of the slider halves will be com-
pletely hidden. Anything to the right 
will be completely visible. Everything in 
between will be partially visible. 

The blending sliders will be used to isolate 
the lightning.
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After the blending sliders have been applied to a layer, a little icon will appear to 
the right of the layer’s thumbnail in the Layers panel. It looks like two overlapping 
squares and is an indicator that the blending settings were changed. Note that 
the effect of the blending sliders is simply a setting that is attached to the layer. 
It doesn’t permanently change the contents of the layer. You can always go back 
and change the settings or undo them later by double-clicking on the icon to the 
right of the layer thumbnail to access the sliders again. 

Now we can drag this lightning layer into a different document that contains an 
image with a different sky. We can always go back and fine-tune the blending slid-
ers once we’ve positioned the layer so that the lightning blends best with its new 
environment. 

Above: The black slider was moved to the right, hiding the 
dark areas in the image (the sky). The slider was also split 
to create a soft transition. Left: This icon means that the 
blending options have been changed.
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When using the blending sliders on the background/bottom layer, it is not always 
easy to see what’s going on because  you’re looking at the transparent, checker-
board pattern behind the layer. To get a better view of how the sliders are affect-
ing the image, we’ll click on the Adjustment layer icon at the bottom of the Layers 
panel and choose to create a Solid Color layer from the menu that pops up. When 
the Color Picker appears, we’ll choose a color that’s similar to the background we 
intend to place the layer on top of and then click OK. Then, we’ll drag the solid 
color layer below the image layer in the Layers panel. 

After using the blending sliders to hide parts of the image, you may find that it 
didn’t do a perfect job and that you have some residual content in areas you’d like 
to be invisible. If this is the case, you can either create a layer mask and paint with 
black on the mask in order to hide those areas, or you can use the Eraser Tool to 
remove the areas (if you know you’re not going to need to bring them back later). 

Make the effect of the blending sliders permanent We mentioned earlier that 
blending sliders are a setting that is attached to a layer. This setting does not ac-
tually remove any parts of the layer. There are, however, some instances where we 
might want to remove those hidden parts of the layer. If we’d like to apply the set-
tings permanently, therefore removing the hidden areas, there is a trick for doing 
that. We’ll create a new, empty layer and drag it directly below the layer with the 

The lightning 
layer was 
placed into a 
different image 
and the blend-
ing sliders are 
being fine-
tuned to make 
it suit the new 
environment.
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blending sliders applied. With the blend-
ing sliders layer active, we’ll go to the 
Layer menu and choose Merge Down. 
The Merge Down command will take 
the contents of the layer we’re currently 
working on and deposit it onto the layer 
that is directly below. When it does this, 
it can’t take any special features along 
with it. Any affects will be permanently 
applied.

In the video example, we used this technique to remove the background on a star-
burst. When placed into a new document, however, the starburst didn’t blend well 
into the new background because there was a dark halo that was residual from 
its original background. To fix this, we’ll click on the foreground color swatch at 

the bottom of the Toolbar and choose 
a yellow hue from the Color Picker that 
appears. We’ll turn off the visibility of the 
other layers and, with the star layer ac-
tive, we’ll click on the transparency lock 
icon at the top of the Layers panel. This 
will protect the transparent areas, mak-
ing it impossible for us to paint any pix-
els there. Then, we’ll use the Brush Tool 
to paint over the starburst. This will paint 
the yellow color onto the starburst with-
out getting any overspill into the sur-
rounding areas. 

The blending sliders were used on the Star 
layer. To make those settings permanent, we 
placed a new, empty layer under the Star 
layer and used the Merge Down command.

Clicking the Lock Transparency icon will 
make it so we can’t add any paint/pixels to 
areas that are already transparent. We can 
only affect areas of the layer that already 
contain some kind of content. 
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In this example, we wanted to isolate the interesting shadow of a tree. To do this, we used the 
“This Layer” blending sliders and dragged the white slider to the left, hiding more and more of 
the light areas of the image. It’s only the shadow we want to be visible. We split the slider to 
create a soft transition between what’s visible and what’s hidden. 
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After isolating an object using the blending sliders, we can fill that area with a spe-
cific color. In the example image, we isolated the shadow of a tree, but we want 
the shadow to be perfectly black. We’ll first need to take the effect created by the 
blending sliders and make it permanent, so we’ll follow the same steps that we 
used above. We’ll create a new, empty layer and place it below the shadow layer. 
Then, we’ll use the Merge Down command (Layer > Merge Down). 

Next, we’re going to use the Fill command to fill the isolated area with black so we 
will make sure that our foreground color is set to black. To fill a layer with the fore-
ground color, we would use the keyboard shortcut Option+Delete (Alt+Backspace 
on Win). This, however, would fill the entire layer. We just want to fill in the areas 
that already contain pixels, which is the tree shadow area. To do this, we’ll use the 
keyboard shortcut Shift+Option+Delete (Shift+Alt+Backspace on Win). Holding 
down the Shift key will temporarily turn on the transparency lock setting, so the 
command can only affect areas that are not transparent (the areas that contain 
pixels). This will fill the tree shadow with our black foreground color. 

Underlying Layer sliders

In the Layer Style dialog, there are two sets of blending sliders. The ones we have 
been working with up until now are the “This Layer” sliders. These sliders control 
the visibility of the active layer based on the brightness level within that active 
layer. The second set is called the “Underlying Layer” sliders. These sliders are still 
going to make parts of the active layer disappear but they’re going to do it based 
on how bright the underlying image is.  For example, if we drag the black slider to 
the right, the darkest areas of the underlying image will start to become revealed. 
If we drag the white slider to the left, the brightest areas of the underlying image 
will start to become revealed. Again, the transition will be abrupt unless we split 
the sliders in half and drag them apart from each other in order to define what 
brightness range is completely visible, which brightness range is hidden and how 
soft/big of a transition there is between them. 
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Make parts of an image less colorful  Let’s say 
that we want to make the dark parts of an image 
less colorful. We would do that by using either a 
Hue/Saturation adjustment layer or a Vibrance 
adjustment layer. In the video example, we’ll cre-
ate a Vibrance adjustment layer and we’ll drag 
the Saturation slider to the left, making the im-
age much less colorful. At this point, the adjustment is affecting the entire im-
age. We’ll double-click to the right of the adjustment layer’s name in the Layers 
panel and this will bring up the Layer Style dialog with the blending sliders. We 
want the bright areas of the image to be in full color, so we’ll want to allow those 

areas to break through the 
adjustment layer and we 
can do this by using the 
white Underlying Layer slid-
er. When we drag this slider 
to the left, the bright areas 
from the underlying image 
will start to be revealed. 
We’ll hold down the Option 
key (Alt on Win) to break 
the slider in half, creating a 
smooth transition. 

The Underlying Layer sliders determine what 
parts of the underlying image will be visible. 
When working with the white slider (the one 
on the right), the area to the right of the slid-
er halves represents the brightness range that 
will be visible. The area to the left of the slid-
er halves represents the brightness range that 
will be hidden. The area between the slider 
halves represents the parts of the image that 
will be partially transparent.

A Vibrance adjustment layer was 
used to make the image less color-
ful. We want to limit the effect to 
the dark areas.

The white blending slider is being used to reveal the 
bright areas from the underlying image.
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Create a two-tone feel to a mostly monotone image  In the next video example 
image, we have an image that is very orange, in both the highlights and the shad-
ows. We want to create more of a two-tone feel to the image and we’ll do this by 
using the blending sliders to introduce a different color into the shadow areas. 
First, we’ll create a Hue/Saturation adjustment layer by clicking on the Adjustment 
Layer icon at the bottom of the Layers panel and choosing Hue/Saturation from 
the menu that appears. In the Properties panel, we’ll turn on the Colorize check 
box and then use the Hue and Saturation sliders to create the color we want to 
insert into the shadows. We adjusted the sliders to create a purple color. Then, 
we’ll double-click in the area to the right of the adjustment layer name in the layers 
panel to access the blending sliders. Because we’re working on an adjustment lay-

er, it doesn’t actually matter which 
of the blending slider sets we use. 
The effect will be the same. We’ll 
go to the “This Layer” sliders and 
drag the white slider to the left 
until the orange highlights from 
the underlying image start to ap-
pear. We’ll hold down the Option 
key (Alt on Win) and split the slid-
er into two halves, dragging the 
halves away from each other to 
create a smooth transition. Now, 
we have the orange highlights 
from the original image along with 
the purple shadows we created by 
using the Hue/Saturation adjust-
ment layer. We can always go back 
to the Hue/Saturation adjustment 
layer sliders to fine-tune the color 
being applied to the shadows. 

A Hue/Saturation adjustment layer was created 
and we’re using the settings in the Properties pan-
el to create a purple hue. (The Colorize check box 
is turned on and we adjusted the Hue and Satura-
tion sliders.)
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Iceland church example  We can 
use the Brush Tool in conjunction 
with the blending sliders to intro-
duce colors into the bright or dark 
areas of an image. In the video 
example image of the Icelandic 
church, I would like to add more 
color into the clouds. Because the 
clouds are the brightest part of the 
image, I know that we can use the 
blending sliders to do this. We’ll 
create a new, empty layer and use 
the Brush Tool to paint an orange/
yellow color over the sky area. It 

The white slider is being used to hide the purple Hue/Saturation layer in the bright areas. 

We want to 
introduce an 
orange color 
to the sky, so 
we’re starting 
by painting 
the color onto 
an empty 
layer.
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will simply be blatant paint that covers everything in the image, so to make it look 
more natural, we’ll experiment with different blending modes. We’ll set this paint 
layer to the soft light blending mode because it looks subtle and natural.  Now, 
we’re going to make the dark parts of what’s underneath (everything except the 
clouds) show through. We’ll access the blending sliders and use the Underlying 
Layer sliders because we want to hide what’s on the paint layer based on what’s 
in the image underneath. We’ll drag the black slider to the right until the building 
starts to break through the yellow paint layer and then we’ll split the slider to cre-
ate a softer, more natural transition. We can always go back and add more paint 
on the layer in order to add variations in color.

The Underlying Layer sliders are being used to allow the dark areas (the building) from the 
image layer to break through the orange color layer.
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Replacing a sky The blending sliders 
can be used to replace a dull-looking 
sky with a more interesting one from 
another image. We’ll first have to place 
the image of the interesting sky above 
the image with the sky we want to re-
place. In the example image, we also 
had to scale the sky up so that it filled 
the area needed. The sky we want to re-
place is the brightest part of the image 
so we will access the blending sliders 
and use the Underlying Layer sliders to 
make the dark parts of what’s under-
neath (everything that is NOT the sky) 
break through. As usual, we’ll break the 
slider in half (by holding the 
Option key while dragging one 
half of the slider) in order to 
create a smoother transition. 
In many cases, we won’t be 
able to create a perfect result. 
There may still be remnants 
of the active layer showing up 
in areas we don’t want it, and 
that is the case in the video ex-
ample. We can still see bits of 
sky appearing over the build-
ing. When that is the case, 
we’ll add a layer mask to the 
top layer and paint on the mask 
to hide the areas we don’t want 
to show up. 

The sky layer we want to used is being posi-
tioned over the sky we want to replace. 

The black Underlying Layer slider is being used to 
make the dark building from the underlying image 
visible. 
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Note: While it’s possible to replace a sky using the blending sliders, I actually pre-
fer to use other methods because there are other techniques that will do a much 
better job. These include the Color Range Command and the Background Eraser.

The Blend If menu

When looking at the blending sliders, there 
is a Blend If menu right above them and 
this menu includes the options of Gray, 
Red, Green and Blue (When working in RGB 
mode). By default, the menu is set to Gray 
and this is the setting we’ve been working 
with up until now. When set to Gray, it thinks 
about your picture as if it’s a black and white 
photograph. It is generally ignoring the col-
ors and thinking only about brightness. 
When we change that menu to one of the 
color choices, it will think about which parts 
of the image contain the most of that color. 
For example, if we set the menu to Red, and 
then drag the red slider to the left, the first 
parts of the image that are affected will be 
the areas containing the most red. 

The Blend If menu is essentially working with 
the different color channels. You can see a 
view of the different channels that make up 
your image by opening the Channels panel. 
If it’s not already visible on your screen, you 
can access it by going to the main menu and 
choosing Window > Channels. If your image 
is in RGB mode, there will be red, green and 

The Blend if menu determines whether 
we’re working on the overall brightness 
or on a specific color channel.

The channels panel shows you the dif-
ferent color channels in your image.
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blue channels. It can be convenient to have the Channels panel open when work-
ing with the color Blend If sliders because it will give you a good idea of what ar-
eas the sliders will be affecting. 

The options in this Blend If menu can be 
useful when you want to isolate an area 
that’s a completely different color from 
its surroundings. In the example image, 
we have a blue iceberg set against a very 
orange sky and water. If I wanted to make 
a change to the iceberg, I could easily 
use a color blending slider because the 
iceberg is a very different color from the 
rest of the image. To determine which 
color slider to use, we can first look at the 
Channels panel for guidance. We want to 
look at the three channels and determine 
which one creates the most separation 
between the iceberg and its surround-
ings. In this case, it’s the red channel. 

For this image, we want to sharpen only the iceberg and the blue reflection un-
derneath it. To do that, we’ll first duplicate the background layer by using the key-
board shortcut Command+J (Ctrl+J on Win) and then we’ll apply our sharpening 
to this duplicate. There are several different options for sharpening an image, but 
we’ll use the Smart Sharpen command, which can be accessed by going to the 
main menu and choosing Filter > Sharpen > Smart Sharpen. We’ll dial in our sharp-
ening settings and then click OK. Now we need to make it so that sharpening is 
only applied to the iceberg area. We’ll double-click in the area to the right of the 
layer name (for the top layer) to bring up the blending sliders and we will set the 
Blend If menu to Red, because that’s the channel where the iceberg best separat-
ed from the background. Looking at the red channel, the background is the area 

In this iceberg image, we can see that the 
red channel creates the most separation 
between the iceberg and the background.
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that’s bright, and the background area is the part that we DON’T want to sharpen. 
Knowing this, we can take the Underlying Layer sliders and move the red slider to 
the left until the underlying, unsharpened layer appears in the background area. 
As always, we’ll separate the slider to create a smooth transition. 

When we are using this technique to apply an effect like sharpening, the result will 
be subtle, which can make it hard to visualize where the effect is visible and where 
it’s not. In an instance like this, we might need to take extra measures in order to 
visualize where the effect is being added. Here’s one way of doing that. We’ll cre-
ate a Color Fill layer by clicking on the Adjustment Layer icon at the bottom of 
the Layers panel and choosing Solid Color from the menu that pops up. The color 
picker will appear and we will choose a color that is blatantly different from the 
rest of the image. In our example, we chose a bright lime green color. Next, we 
want to make it so this layer is only visible in the areas where the underlying layer 

The Underlying Layer slider is set to work with the red channel and we’re dragging the red 
slider to the left, revealing the underlying, unsharpened image in the bright areas. 
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is also visible. To do this, we’ll make sure the color fill layer is active and then we’ll 
go to the Layer menu and choose Create Clipping Mask. Now, the bright green 
color layer will only appear in the areas where the underlying, sharpened layer is 
visible and this will give us a better visual reference to go by. We can now easily 
paint on a layer mask attached to the sharpening layer and hide the layer in areas 
where we don’t want the sharpening to be applied. 

Note that you can also create a clipping mask by holding down the Option key 
(Alt on Win) and clicking on the horizontal line between the active layer and the 
layer beneath it within the Layers panel. 

Here, we created a green solid color layer and then added a clipping mask so that it only 
appeared in the areas where the underlying layer contained pixels. 
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Add color to an object that doesn’t currently have color In the next example, we 
have an image of a white car and we’d like to colorize it. Usually, when adding col-
or to an object like this, we’d have to apply separate colors to the highlights, the 
shadows and the midtones in order for the result to look natural.  Here’s how we 
can go about it. We’ll first create a solid color layer by clicking on the Adjustment 
Layer icon at the bottom of the Layers panel and choosing Solid Color from the 
menu that appears. The Color Picker will pop up and we’ll choose the general col-
or for the car. In this example, we’ll choose a blue color and then click OK. To apply 
the color to the car, we’ll set the blending mode of the solid color layer to Multiply. 
The Multiply mode acts like ink.

Now the blue color is covering the entire image and we’d like to make it so it only 
covers the car. To do this, we’ll temporarily turn off the color layer so that we can 
accurately make a selection around the car using the Quick Selection Tool. To 
ensure that the selection is accurate, we can tap the Q key to enter Quick Mask 

A color fill layer was created and set to the Multiply blending mode. Then, we created a se-
lection around the car, which is the only area we want to contain the blue color.
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Mode, which will give us a view of our selection as a red overlay. Once we’ve fine-
tuned the selection, we’ll tap the Q key again to exit Quick Mask Mode and we’ll 
turn the visibility of the color layer back on. 

With the selection active, we need to apply that selection to the layer mask so 
that it limits where the blue color is appearing on the image. Because we’re going 
to need more than one layer to apply the different shades of blue necessary, we’ll 
create a layer group (aka folder) by clicking on the folder icon at the bottom of 
the Layers panel. Then, with the group active, we’ll click the Layer Mask icon at 
the bottom of the Layers panel. Because there was a selection active, it will au-
tomatically be applied to the layer mask. Anything we place inside this group will 
only show up where the mask allows it to (where the mask is white). We’ll drag the 
color fill layer into this layer group so that the blue only appears on the car. 

The blue solid color layer was placed into a layer group and the selection was used to apply 
a layer mask to the group. This limited the blue color to the car.



Blending Sliders © Ben Willmore, All rights reserved 21

At this point, the car doesn’t look completely natural because the highlights are 
the same color as the shadows and the midtones. To fix this, we need to limit 
which parts of the car the solid color layer can affect. We’ll double-click in the area 
to the right of the solid color layer name to call up the blending sliders. We’ll use 
the Underlying Layer sliders, dragging the white slider to the left in order to hide 
the blue color in the highlight areas in the car. We’ll also drag the black slider in 
to hide the blue color in the shadows. We’ll then split both sliders to create soft 
transitions and then click ok. 

Next, we want to insert different, less colorful, shades of blue into the highlight 
and shadow areas of the car. We’ll create a new solid color layer inside of the layer 
group, we’ll choose a darker, less saturated color for the shadows and then we’ll 
click OK. This color should only appear in the shadow areas of the car, so we’ll 
access the blending sliders, use the Underlying Layer sliders and drag the white 

The blending sliders are being used to hide the blue effect in the highlights and shadows of 
the car. 
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slider to the left, until the dark hue only appears in the shadow areas. Note that it 
may be easier to see what’s going on if the visibility of the original solid color layer 
is turned off. After clicking OK, we’ll set the blending mode of this dark blue layer 
to Multiply. Then, we’ll follow a similar procedure for the highlight areas. We’ll cre-
ate another solid color layer inside of the layer group and we’ll set the color to a 
lighter, less saturated version of the blue color. We’ll set the blending mode of this 
color layer to Multiply as well. We’ll access the blending sliders and use the Under-
lying Layer sliders, dragging the black slider way to the right, hiding the dark blue 
in all areas except for the shadow areas. 

Now the car is starting to look more natural because there is the main blue that 
covers the majority of the car, and there are lighter and darker versions of the 
same blue for the highlights and shadows. We can finally fine-tune the results us-
ing layer masks. 

A darker, less saturated color layer was created for the shadow areas of the car. The white 
Underlying Layer slider is being used to limit the dark blue color to those shadow areas.


